
WinPolis    
Thank you very much for your interest in WinPolis.    What follows is a listing 
of headings under which you can find out everything you need to know to 
play WinPolis as well as to order the full version of WinPolis.

- What's "shareware"?
- Order full version
- The rules of WinPolis

- Buying and selling 
- The "Game" menu 
- The "Transactions" menu 
- The "Settings" menu
- The "Strategy" menu 
- The "High Scores" menu 
- The "Help" menu

- Setting up a game
- Some questions for the Question Square
- Sound settings

- Color legend

- Problems with the game board size

- WinPolis in CompuServe

To make suggestions or place an order, please contact:

Christian Jung
Zum Stiefel 35

D-66386 St. Ingbert
GERMANY

CompuServe: 100414,673

A closing thank-you:



I would like to express my sincere gratitude to everyone who helped with the
design of WinPolis, and especially to Silke and Willi, who both contributed a 
great deal to the present version of the game.

Also a very big thank-you to Andrew Johnson, who translated the German 
version into English and offered many helpful suggestions as well.

A large portion of the game's graphics are based on data in the library for 
Corel Draw 4.0, for whose free use I would also like to express my gratitude.



Ordering and Getting Help via CompuServe
If you have access to CompuServe, you can download the most up-to-date 
shareware version of WinPolis, order the full version, or request help with this
program.    Just proceed as follows:

a) Downloading the latest shareware version

By selecting the "About WinPolis" option under the "Help" menu you can see 
the version number and date of your shareware version. If this date isn't 
recent, you can download the latest shareware version from CompuServe.

You'll find the programs in CompuServe's PCPRO Forum (GO PCPRO).

If you have any questions, contact me (100414,673) or the Sysop of the 
forum.

b) Pointers and suggestions regarding my programs

To offer criticism or receive help with the full version of WinPolis, simply send 
me a message:

Christian Jung, 100414,673

c) Ordering the full version

You can order the full versions of WinPolis directly through CompuServe.    For
this purpose there is a forum called SWREG (GO SWREG).

The process goes as follows:

In the SWREG Forum select "Register Shareware" and then enter the name of
the region in which you live.    This information is needed to calculate postage
charges.    Then you can search according to various criteria, such as 
program name or description.    But it's best to search using the 
REGISTRATION ID of the desired program, since it provides a uniquely 
distinguishing characteristic.    

The full version of WinPolis has the ID number 3735.

After entering the ID number you'll be shown a description of the program, 
and you can decide whether or not to order it.



If you do order, I'll receive notification the same day and send you the 
desired program.    The charge for the program will show up on your next 
CompuServe bill.

The Size of the Game Board
WinPolis offers a game board the full size of the monitor screen in resolutions
of 640x480, 800x600, and 1024x768 pixels.    This last resolution provides 
the highest quality graphics, since in the lower resolutions the integrity of 
certain pictures is compromised.    Therefore, if possible, you should work in 
1024x768 resolution, or at least 800x600.

Higher resolutions are not yet supported; if you are using one of them, the 
WinPolis game board will not fill the entire screen.

In very rare cases the game board will not fit on the screen because WinPolis 
doesn't recognize the resolution of your video card.    Should this happen to 
you, just start the program with the following parameters:

640:    To set the size of the game board to 640x480 pixels.

800:    To set the size of the game board to 800x600 pixels.

1024:    To set the size of the game board to 1024x768 pixels.

For example:    Select the "Run" option from the "File" menu of Windows 
Program Manager and type "WinPolis.exe 640".
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Some Questions for the Question Square
Whenever you land on the Question Square, you are posed a Yes/No 
question.    The questions come from the file "question.txt", a pure text file 
which therefore can be read using any Windows text editor.

To enter your own questions or to change the existing ones, just load this file 
into a text editor.

The file is structured as follows:

Every question consists of three lines:

First there is the question itself.

In the second line you will see either a "1" or a "0".    "1" means that the 
question must be answered "Yes", "0" that the question must be answered 
"No", in order to receive the desired
W$3000.

The third line contains the correct answer if the question should be answered
"No" (that is, if the second line contains a "0").    The third line is left empty if 
the question should be
answered "Yes" (that is, if the second line contains a "1").

Should you wish to add your own questions, the questions provided with the 
game should furnish you with plenty of examples.    And there is no limit to 
the number of questions that
can be added.



    



The Fundamental Principles of Shareware
WinPolis is shareware.    That means it exists in two versions:    a shareware 
version and a full version.

The shareware version costs only a little or nothing at all, and the author is 
not informed about the purchase of a shareware version. Thus the advantage
for you as a user of the shareware version is that you can try out the 
program in peace, in order to decide whether you want to continue to use it.  
Generally such a trial should be finished in 3-4 weeks.    If upon completion of
the trial period you decide you like the program, you should order the full 
version; otherwise you should delete the shareware version.

Long-term use of the shareware version is not permitted!!!

By ordering the full version you receive the latest version of WinPolis, in 
which all the options that are deactivated in the shareware version are 
accessible.    That means you can:

-- change settings
-- configure the sound
-- play the super background melody
-- forget about the tiresome messages regarding how to order the full version
-- count on receiving information about new versions and programs

In the "Help" menu you'll find the option "Place an order," which you
can use to print out an order form for the full version.

So, enjoy the program - and show those electronic louts how one ought to 
handle one's money!



The Rules of WinPolis
In WinPolis everything revolves around money - or to be more precise, 
around WinPolitan dollars (W$), so named for WinPolis, where the action of 
WinPolis takes place.    Hence the
object of the game is to try to get your opponents' money by purchasing and
enhancing businesses as wisely as possible.

Players take turns moving across the game board and can purchase a 
business only when they land on it.    When a player lands on an opponent's 
business, the player shops there and thus has to pay a bill.

A player automatically moves forward the same number of squares as the 
total of his or her dice roll.    You roll by clicking the roll button or pressing the
space bar.    If a player rolls a double, he or she gets to roll again.

When two player-figures land on the same square, the one that arrived 
second conceals the one that arrived first.    If you can't find your player-
figure, click your mouse button while
pointing to your home base (where your cash holdings are displayed) and it 
will become visible again.

Should you be in doubt about the nature of a square, simply put the mouse 
pointer on it and click the left mouse button to see the name of the square or
the business located there.

Once a player has acquired all the businesses of a certain type, for example 
all pharmacies, he or she can enhance them and thereby dramatically raise 
their value.    When an opposing player
lands on a store that has been enhanced, he or she has to purchase an 
amount of goods or services proportional to the level of enhancement.    In 
addition, the cost of goods or services a player has to purchase in an 
opposing player's business doubles when the opposing player owns the 
whole chain of businesses.

If a player is unable to pay a bill, even on credit, he or she loses.    All his or 
her businesses must be relinquished and become available for other players 
to buy.

Not all the squares on the game board contain businesses; there are also 
several so-called "Action Squares":

The Start Square



Here every player begins his or her trip through WinPolis. Furthermore, every
time a player crosses this square, he or she receives interest on his or her 
assets.

The Question Square

When you land on this square, you are given a chance to demonstrate your 
knowledge:    You are asked a question, and earn W$3000 for a correct 
answer.

The Mail Square

This square displays a mailbox, in which you will find mail for yourself every 
time you land on the square.

The Price Inflation Square

When a player lands on this square, the prices in his or her stores rise.    In 
addition, it is only while on this square that players can cash in CDs without 
having to pay an early withdrawal penalty.

The Ignorance Square



A player who lands on this square receives the contents of the Ignorance Pot:
namely, the money that has been paid by players because of incorrect 
answers they gave while on the Question Square.

The Vacation Square

A player who lands on this square goes on vacation for a turn.

The Casino Square

This square takes you into the Winpolitan Casino, where one can win or lose 
huge sums of money.



The Start Square

Every player who crosses this square receives W$4000 in interest if he or she
doesn't have any debts (negative cash).    If he or she does have debts, some
of this interest is withheld.    In the
worst case, the player still receives W$2.

When a player lands directly on the Start Square, he or she receives 
W$8000, regardless of how much cash he or she has.

Also, the interest due a player from his or her CDs is paid out when he or she
crosses or lands on the Start Square.



The Question Square

When a player lands on this square, he or she must answer a question.    The 
prize for a correct answer is W$3000; if the player answers incorrectly, the 
same amount must be paid as a
penalty, and is added to the contents of the Ignorance Square.

Should you wish not to be asked a question when you land on the Question 
Square, you can shut off this function.    Just go to the "Settings" menu and 
switch off the "Ask questions" options.    The Question Square then becomes 
a tax square, that is, players must pay taxes when they land on it.

It is possible to enter your own questions for the Question Square.    You'll find
instructions on how to do this under "Some questions for the Question 
Square."



The Mail Square

The Mail Square displays a mailbox.    When a player lands on this square, he 
or she receives a "letter," or at least something along the lines of a letter, 
which typically contains some sort of sassy message.    This message will 
inform you whether you owe money or are the lucky recipient of a few 
Winpolitan dollars.



The Price Inflation Square

The First Bank of WinPolis is located on this square.

When a player lands on this square, all the prices in the businesses he or she
owns at that time go up 5%.    That means that when an opponent goes 
shopping in one of these businesses, he or she has to pay 5% more than 
before.

The Price Inflation Square ceases to work its wonders once the prices in a 
business have risen 50%.

A business's inflated prices are reset to their original levels when the 
business is sold or traded.

The Price Inflation Square has a second function:    Since it contains the First 
Bank of WinPolis, a player can, while on this square, cash in any CDs he or 
she has at the bank without having to pay a fee.    This is accomplished by 
selecting the appropriate option from the "Transactions" menu.    Cashing in 
CDs while on any other square carries a 20% processing fee.



The Ignorance Square

Whenever a player on the Question Square answers a question incorrectly, 
he or she has to contribute W$3000 to the Ignorance Pot.    When a player 
lands on the Ignorance Square, he or she receives its entire contents.

In order to see how much money the Ignorance Pot holds at any given time, 
just click the right mouse button with the mouse pointer positioned on the 
Ignorance Square.



The Vacation Square

When a player lands on this square, he or she goes on vacation or, in other 
words, sits out for one turn.

But if the player lands on the Vacation Square as a result of rolling a double, 
he or she gets to come back early (without having to skip a turn).    But the 
double is treated as a normal roll, meaning that the player doesn't get to roll 
again.

A player also earns a vacation by rolling three doubles in a roll.    (All that 
racing around wears a person out!)



The Casino Square

Behind this square hides a game within the game:    the card game 
"Blackjack."    Should the player choose to play, his or her objective is draw 
cards whose value totals as close as possible to 21 without going over (or 
"busting").

The player draws first.    When he or she is satisfied with his or her hand - and
hasn't busted - the player may choose to stand.    Then it's the dealer's turn 
to draw.    The dealer also tries to get a hand that totals as close to 21 as 
possible without going over.

A game of blackjack may end in any of the following ways:

a) The player busts, in which case he or she loses triple his or her bet.

b) The dealer busts, in which case the player wins triple his or her bet.

c) Neither the player nor the dealer busts, but the dealer's hand comes 
closer to 21, in which case the player loses twice his or her bet.

d) Neither the player nor the dealer busts, and the player's hand comes 
closer to 21, in which case the player wins twice his or her bet.

e) The player and dealer tie, in which case they play again.

At the end of every round, the player is given the opportunity to decide 
whether to play again or return to WinPolis.

Card values in Blackjack

-- Number cards are worth their face-value.

-- Face cards (kings, queens, and jacks) are worth 10 each.

-- Aces are worth 1 point each.



The "Game" Menu
In this menu one is given the option to load a game, save a game, or start a 
new game.    One is also given the option to exit WinPolis in this menu.

To load a game, select the "Load" option from the menu and then enter or 
double-click the name of the saved game you wish to load.

To save the current game, select the "Save" option from the menu and then 
enter a name of at most 8 characters in the appropriate box.    The extension 
(".wsp") will be supplied automatically.

To start a new game, select the "Start new game" option.

Tip: 

There are sometimes games in which all players continue to enjoy financial 
success with no end to the game in sight.    To end such a game, select the 
"Start new game" option.    You will
then have the opportunity to incorporate the results of the current game into
the list of high scores, even though the game wasn't over.



Buying and Selling
The key to winning in WinPolis is to own as many businesses as possible and 
have them enhanced as much as possible - while of course leaving oneself 
enough of a financial cushion to pay one's bills.

In order to purchase a business, one has to be standing on the corresponding
square.

-- To buy the business, click the "Buy" button.
-- To refrain from buying the business, click the "Don't buy" button.
-- To examine the costs of and returns for enhancing the business, click the 
"More" button.

After a successful purchase, the amount of cash you own decreases by the 
price of the business, and your credit limit rises by 70% of that price.

To enhance a business and thereby make it much more profitable, one has to
own all the businesses in that category - for example all pharmacies - and, in
addition, be standing on one of them.

The cost of enhancing a business increases as the following actions are 
carried out:

1) Add furnishings
2) Add merchandise
3) Add management
4) Add personnel
5) Sign long-term lease

The actions have to be taken in the order listed; hence, you can't buy 
merchandise until you have added furnishings, and you can't sign a long-
term lease until you have added furnishings,
merchandise, management, and personnel.

To perform one or more of these actions for a store, simply click the store in 
question using the right mouse button.    The border of the store will be 
highlighted in white, and a window
will appear in which you can decide either to add or remove enhancements.   
Enhancements can be removed only in only in the reverse of the order in 
which they were added.

In the upper right-hand corner of the window you'll see what the selected 
enhancement costs or what the selected sale yields.    If, for example, you 
click "inventory" when you still haven't



acquired furnishings, you'll see the price for inventory and furnishings 
together, since inventory cannot be purchased until furnishings have been 
added.

Selling Businesses:

Only businesses that aren't enhanced can be sold.    To sell a business, 
position the mouse pointer on it and click the right mouse button while you 
are standing on either that business or
one of the other businesses in the same chain.    A window will appear which 
will allow you to carry out the sale.

But selling a business always yields only 80% of the price for which you 
bought the business; so think carefully before you sell, since you lose money 
on your investment when you do so.



The Credit Limit

The credit limit indicates by how much money a player can overdraw his or 
her bank account.    A player loses if he or she has to exceed this limit.



The "Transactions" Menu
Use this menu to transact business with an opponent or with the bank.

The first option in this menu allows you to propose a swap of businesses with
an opponent.    The second allows you to try to buy a business from an 
opponent.

In addition, all actions having to do with CDs are carried out using this menu. 
You can invest in or cash CDs at any time (though cashing them when you're 
not located on the bank carries with it a 20% early withdrawal penalty).



Swap Businesses
In order to acquire a whole chain of businesses, it is often necessary to swap 
businesses with an opponent.    That transaction is accomplished as follows:

Using the mouse, highlight in turn each of the two businesses that will be 
involved in the proposed deal.    Each time a window will appear which 
displays the costs of enhancements to the business and the returns the 
business yields at the various levels of enhancement.    Click on the option 
"Highlight for negotiations" and then click "OK."    This will highlight in white
the border of the square on which the business is located.

Now select the "Swap businesses" option in the "Transactions" menu.    A 
window will open, showing who is offering what to whom. You are given the 
opportunity to add cash to your offer, or request cash from the opponent 
with whom you wish to trade. 
When you have specified the deal just as you want it, click "Offer deal" and 
wait for your opponent's response.

If the opponent with whom you wish to trade is a computer-player, his 
response will depend substantially on the settings in the "Strategy" menu.



The "Strategy" Menu
By adjusting the settings in this menu, you can vary the style of play of your 
computer-opponents.    The possible settings are as follows:

Computer plays egoistically:    The computer-player makes it his overriding 
objective to win the game and thus will trade businesses only when doing so 
brings him an advantage.

Computer negotiates freely:    The computer-player has as his primary 
objective to make the game exciting.    So when he's playing in this mode, he 
may well trade away a business even if
it isn't clearly to his advantage.    Thus when this setting has been selected, it
is unlikely that no player will be able to acquire a whole chain of businesses 
and enhance them.

Computer plays unpredictably:    This represents a mixture of the two 
preceding strategies.    On one occasion the computer-player will offer you a 
terrific deal; on another occasion he will be as stubborn as a mule and refuse
to part with anything.    When playing in this mode it makes a lot of sense to 
suggest a particular deal frequently, since the computer-player's responses 
can be variable, or even unpredictable.



Purchase Business 
If you would like to purchase one of your opponent's businesses, just click 
the business in question with your left mouse button. A window will open 
showing the prices and returns for that business.    Activate the option 
"Highlight for negotiations" and click the "OK" button.    This will highlight the 
border of the business in white.

Now choose the "Purchase business" option in the "Transactions" menu and 
enter the amount of money you want to offer your opponent for his or her 
business.

Then select "Offer deal" and await your opponent's response.

If the opponent is controlled by the computer, his response will depend 
substantially on the settings in the "Strategy" menu.



One owns a chain of businesses when one owns all the businesses of a 
certain type, for example, all pharmacies.



The "Settings" Menu 
You can use this menu to stipulate who your opponents should be and 
moreover to change certain rules.

The settings having to do with sound are also found in this menu.



Stipulate Players 
Use this option to determine which players will participate in the game and 
which players will be controlled by the computer. This option also gives you 
the opportunity to enter names for
players.

For the first player it is possible only to enter a name, as this player cannot 
be deactivated and cannot be set to be controlled by the computer.

For the three other players you can not only enter names, but also determine
whether they will play along (by activating or not activating the "Playing" 
option) and whether they will be
controlled by the computer (by activating or not activating the "Computer" 
option).

Please note that changing the settings in this window terminates the current 
game! 



Change Rules 
Note:    Most of the settings for WinPolis are set to their default values in the 
shareware version and cannot be altered there.    This privilege is reserved 
for owners of the full version.

The following settings can be adjusted:

Ask questions

If you wish, you can deactivate the Question Square, so that it won't pose 
questions to players.    The square then becomes a tax square, on which 
every player must pay taxes.

Earn money on vacation

A player on vacation normally cannot earn money.    Thus, if another player 
lands on one of his or her stores while he or she is on vacation, the other 
player doesn't have to pay anything.

If you don't want that, activate this option.

Report computer-player transactions

Normally you informed about one computer-player's patronizing another 
computer-player's store.    If these messages bother you, just switch off the 
"Report computer-player transactions"
option.    This will also suppress some generic messages, such as the one that
reports how much money a computer-player receives when he or she crosses
the Start Square and the one that appears when a computer-player 
purchases or cashes in CDs.

Permit CD purchases

When this option is activated, players can purchase or cash in CDs at the 
First Bank of WinPolis.    If you would rather play without this capability (which
can extend the length of a game significantly), deactivate this option.

Permit computer-player trades

If more than one computer-player is playing, the computer will allow 



mutually advantageous trading of businesses between computer-players.    If 
you want computer-players not to be able
to make trades, switch off the "Permit computer-player trades" option.

Play in English

This option allows you to change the language used in WinPolis. You can 
choose either German (option not checked) or English (option checked).

Beginning capital

Enter here the amount of money you want each player to begin the game 
with.

Ending capital

The value you enter here determines how much money a player can make 
before the game ends.    Once a player's net worth reaches this limit, the 
current game ends.    The players who are still active can then have their 
scores added to the list of high scores if they qualify.

The default value here is the highest value WinPolis can process 
(2,147,483,647 WinPolitan dollars).    No value greater than this can be 
inputted.

And of course you cannot enter a value for the ending capital unless its 
greater than the beginning capital.

Interest on CDs

Enter here the percentage of interest that CDs should earn.    Values from 0% 
to 20% are possible.

Pause between two moves

Here you can decide how fast the player-figures should move.    The smaller 
the number you input, the faster players will move around the game board.    
Valid values range from 150 to 999 milliseconds.

 



The High Scores List 
After every game the program checks to see whether the players in that 
game were good enough to earn places in the WinPolitan High Scores List.    
Here you will find listed the 10 greatest WinPolis players in order of 
decreasing value of assets.    The value of a player's total assets is computed 
by adding the values of his or her cash, CDs, and businesses.

To view the high scores list, select the "Show high scores" option.    This list is
displayed automatically at the end of every game.    New entries to the list 
are indicated by an arrow. 

So if you don't see any arrows when viewing the high scores list after a 
game, that means that none of the players in the just-finished game 
accumulated as much wealth as the number 10
player in the high scores list.

You can also reset the high scores list by selecting the "Delete high scores" 
option.

Tip:    

If you select the "Start new game" option when a game is already in 
progress, you are given the opportunity to include the results of the current 
game in the high scores list, even though the current game isn't over.    This 
makes sense if the current game has evolved in such a way that two or more
players continue to increase their wealth with no end in sight, but you
still want the results that have been achieved to appear in the high scores 
list.



The "Help" Menu 
The "Help" menu allows you not only to call up help on the various features 
of WinPolis, but also to print out an order form for the full version of WinPolis.

Contents:    Presents a list of help topics.

About WinPolis:    Gives the names of the designers of WinPolis.

Color legend: Explains the meaning of colors which appear on the border of 
squares containing stores that have been enhanced or highlighted for 
negotiations.

Important information about the full version:    Tells you everything you need 
to know to order the full version of WinPolis.

Print order form:    Prints an order form which you can use to order the full 
version of WinPolis.

Pay attention here to the pertinent information given under "Order full 
version."



Order Full Version 
I appreciate the honesty you've shown in deciding to order the full version of 
WinPolis.    A few short hints on how best to go about this:

The full version of WinPolis costs $25. For this you'll receive the latest version
of the program, as well as the opportunity to acquire any future version at a 
special price.    In addition, the full version of WinPolis gives you access to all 
the game's functions.

Simply click "Print order form" in the Help menu to call up the order form.

Fill out the order form legibly and send it to:

Christian Jung
Zum Stiefel 35
66386 St. Ingbert

GERMANY

Or send your order via CompuServe to:

Christian Jung
100414,673

You can also get the full version as CompuServe mail, if you add $10 for 
sending as binary-mail. Just send me your creditcard-number and expiration 
date (Master/VISA). You'll get WinPolis within one or two days.

 



Order Form for WinPolis

Mr.
Christian Jung
Zum Stiefel 35

D-66386 St.Ingbert
GERMANY

I would like to order

___ copy/copies of the full version of WinPolis at $25.00 each (3.5" diskettes).

_1_ Shipping & Handling : $5.00

Total price: ___________

Payment by:    

[      ] Money order        

[      ] Eurocard (Mastercard)                                          [      ] Visa

Card number: __________________________________                  Expiration date: ____/____/____

You can also order through CompuServe's SWREG Forum (see "Help" menu).

Please send as soon as possible to (please print your name and full address, including 
country, legibly):

Name: _______________________________________________________________

Address: _______________________________________________________________

City, ST 
Zip: 

_______________________________________________________________

Country: _______________________________________________________________

Signature: ________________________________________



City: _______________________          Date: ____/____/_____



Setting Up a Game
In addition to loading and saving games in WinPolis, it is possible to set up 
certain game situations.

This can only be done, however, when WinPolis is started with the "SET" 
parameter.    Using Windows File Manager, highlight the "WinPolis.exe" file 
and select "Run" from the "File" menu.    Then enter the word "SET" after the 
name of the file.

Next you can determine how much money each of the players should have.    
Just position the mouse pointer on one of the player boxes in the middle of 
the game board and click the right mouse button.    A window will be opened 
which allows you to enter the amount of cash you want each player to have.

You can also assign individual stores, with or without enhancements, to 
players.    Start by clicking the respective store with the right mouse button.   
This will open up a window
in which you can predetermine any of the settings shown.    Of course you 
still have to adhere to the holy rules of WinPolis (thus you cannot enhance a 
business until you own all of the
businesses in its chain, etc.).

Note:    After you have made the desired adjustments to the settings, you 
should save the game and restart WinPolis without the "SET" parameter.    In 
a game started with this parameter it
isn't possible to enhance businesses.



Information About a Business
The information window "Business settings" shows not only a business's 
name and the type of business it is, but also the prices of enhancements and
the returns each level of enhancement
brings.

"Returns" for a particular business enhanced to a particular level refers to 
the amount of money the owner of that business receives when another 
player lands on it.    Thus, for example, returns of W$1600 at the 
"Management" line for a particular business means that the owner of this 
business will receive W$1600 when another player lands on this business 
and the business has had management added to it (and hence all the 
enhancements below management).

The returns for an unenhanced business double when the owner owns all the 
businesses of the type in question.



Configure the Sound
Note:    Most sound options, such as that for background music, are available 
only in the full version of WinPolis.

WinPolis offers you the capability of assigning each square a sound to be 
played each time the business located on the square comes available for 
purchase or is patronized.    You can
determine whether a sound should be played, and if so, which sound.

New with version 2.0 is the option of adding background music.

Of course it is a necessary condition for accessing these sound functions that
you have a soundcard installed in your computer and that the soundcard 
have been set up for Windows.

Switch On/Off Sound

Select the option "Set sounds" in the "Settings" menu.    A window will appear
in which you will find, among other things, an "Activate music" switch.    This 
switch can be activated or
deactivated by clicking it using the left mouse button.    If the box next to 
"Activate music" has an "x" in it, this means that music has been activated; 
otherwise the music is shut off.

Limit Music

If you activate the switch "Play music only for purchases", you'll hear music 
only when a business comes available for purchase (and not when a player 
patronizes it).

Select Sound Files

You can assign each square its own sound.    This sound must be available in 
the form of a ".wav" file.    Just enter the name of the file in the appropriate 
box.    If the file is not located in
the same subdirectory as WinPolis, you'll have to enter the full path of the 
file along with the file's name.

Background Music



You can activate background music by clicking on the "Background music" 
option.    The background music is deactivated by clicking the option again.    
Note that this option is available only to those users who have a MIDI-
compatible soundcard.



Invest in CDs
You can invest a portion of your money into CDs at any time.    By doing so 
you'll receive interest on your CDs, above and beyong the normal interest 
you receive on your bank account, every time you cross the Start Square.    
You determine the rate of interest before the game starts using the 
"Settings" menu.

Buying CDs is easy to do.    Just select the "Buy CDs" option in the 
"Transactions" menu and enter the amount of money you would like to put 
into CDs.

To cash in CDs select the "Cash in CDs" option from the same menu.    But 
note that if you cash in your CDs when you are not on the Price Inflation 
Square (where the First Bank of WinPolis is located), you are assessed a 20% 
penalty for early withdrawal.    Only while at the bank can you cash in your 
CDs penalty free.

You should also note that you are not allowed to cash in your CDs in order to 
pay a bill that you've suddenly and unexpectedly been hit with.    If in such a 
situation you don't have sufficient cash and/or credit, then even if you have a
fortune in CDs, you're out of luck!

Therefore, you should always be sure to cash in your CDs early enough to 
avoid this kind of financial disaster.




